Appendix B: Additional Navigation Topics

- This appendix contains detailed information on many of the topics introduced in the eLearning tutorials in Unit 2: Navigation. The “must know” information was covered in the eLearning tutorials. Additional information that may be of help to you when you perform day-to-day job functions using AIS is provided here.

- We have referenced the eLearning tutorials where the information first appeared, under the section headings.

Navigator Window Functions - Top Ten List

(Unit 2: Navigation, Module 2: Windows; Learning Cycle 1: Navigator Window Functions)

- The Top Ten List allows you to create your own navigation list for frequently used forms.
  - Choosing a form is quicker and more convenient.
  - The list may contain up to ten items.
  - Only the items without a plus or minus can be placed on the Top Ten list.
  - The list is unique to the responsibility and person.

Navigating Using the Top Ten List

- The items on the Top Ten List are numbered; these numbers may be used to navigate.
  - From the keyboard, type in the number next to the form i.e. “1”.
    - The function is automatically highlighted and the highlighted form displays.

- Alternately, highlight the item on the list and
  - Click Open
  - Or, double-click the Top Ten List item to open the form.

Navigator Window Functions - Documents Region

(Unit 2: Navigation, Module 2: Windows; Learning Cycle 1: Navigator Window Functions)

- The Navigator window contains two Alternative Regions, Functions and Documents. The Functions were covered in the eLearning tutorial. This section provides information for using the Documents Region.

- Click the Documents tab on the Navigator Window.

- The Navigator Documents Region displays.

- This region is used to create links to specific windows or forms.

- Links are created while the document to which you wish to link is open.
  - You can create as many links as needed.

- Clicking the Function tab displays the default Navigator window.
• **Adding Documents** to the Documents Region
  - From the Navigator, open the form or window for which you are creating a link.
  - From the **File** menu, select **Place on Navigator**.
  - From the **File** menu, select Close Form to return to the Navigator window.
  - The Documents Region displays an icon for the added document. Notice the radio button **Icon View** is selected by default. If you prefer viewing a list of documents rather than the icon, click the **List View** radio button.

• If there are documents on the Documents list, the Navigator window will always open displaying the Documents Region.

• To open the document from either view:
  - Highlight it and click **Open**
  - Or, double-click.

• **Renaming Documents** in the Documents Region
  - Select the document that is to be Renamed either in Icon or List view format.
  - Click **Rename**.
  - The **Rename Label** window displays.
  - Highlight and delete the **New Label** field contents; enter a new name in the field.
  - Click **OK** to complete the process.

• **Removing Documents** from the Documents Region
  - Select the document to be removed.
  - Click **Remove**.
  - Removing a document from the list does not affect the document itself.
  - A **Caution** window displays to confirm your intent to remove the document from the Navigator window.
  - Click **OK**.
  - The Document is removed from the Documents Region of the Navigator window.

• Click the **Functions** tab to return to the Navigator Functions Region.
Navigating Within a Window – Additional Information

(Unit 2: Navigation, Module 2: Windows; Learning Cycle 4: Navigating within a Window)

Record to Record

**Note:** It is important to pay attention to the **Message** and **Status Lines** on the **Task Bar** at the bottom of the window. Important messages are displayed here. It is particularly beneficial to utilize the Message and Status lines when viewing records in a multi-record block.

- As you arrow through the records, notice the changes to the Record number displayed on the Status Line of the Toolbar.

- When the window opens the Status Line displays the Record Number (1) according to the position of the Current Record Indicator; record 1 of an undetermined number of records. To find out how many records there are, you must navigate to the end of the list. As you move the Current Record Indicator through the record block and additional records are brought in to view, the number changes to indicate the number of the record chosen.

- When the last record is reached:
  - The Status Line on the Task Bar displays the total number of records (i.e., Record 336/336).
  - A **Forms** window displays telling you the "Last record of query retrieved", click [OK] to close it.
    The same message displays on the Message Line on the Toolbar.

**Note:** If you use the **View** menu ➔ **Record/Last** option and several hundred records exist, a **Decision** window displays: “100 more Records have been retrieved and an unknown number of additional records remain”. You will have to decide whether to “Stop”, “Continue to End”, or “Continue”. Depending on the decision made, this could be very time consuming. When this happens, it is best to re-query using a more specific search to retrieve fewer records.
Entering Data – Additional Information

(Unit 2: Navigation; Module 5: Entering Data; Learning Cycle 1: List of Values)

Oracle’s Calendar Feature

- When entering dates on a data entry form in Oracle, the date must be entered in Oracle Date format.
  - You can manually enter the date in Oracle’s date format (DD-MMM-YYYY).
  - Or, invoke the List of Values from the date field and use Oracle’s Calendar feature to enter the date.
- When a LOV indicator is available in a date field, clicking on it displays Oracle’s Calendar.
- This section will give you a brief overview of how to use Oracle’s Calendar feature to populate a date field.

![Oracle Calendar Feature Diagram]

- The Selected Date is the current date or the date displayed in the active field.
- The Day Selector Area displays six rows of days.
  - Days in bold are in the displayed month, in this example, for November.
  - Days in normal print are in the previous and/or next month.
  - Days blocked in gray are days that cannot be selected for this field.
- To select a different month:
  - Click the arrow buttons in the Month Selectors area or press the [▼] and [▲] on the keyboard.
  - Down arrow displays previous months.
  - Up arrow displays future months.
- To select a different year:
  - Click the in the Year Selectors area.
- As you select different months, years, and days, the display in the Selected Date area changes accordingly.
- Clicking will populate the date field with the settings you selected using the Calendar feature.
- Clicking will clear any settings selected and will exit the Calendar feature.
Reporting – Additional Information

(Unit 2: Navigation; Module 6: Reporting; Learning Cycle 2: Viewing Reports)

Additional information that is available by accessing the buttons at the bottom of the Report Requests window was not covered in Unit 2 Navigation, Module 6: Running Reports. It is documented below.

Requests Window

- When the Phase equals Completed, View Details…, View Output, Diagnostics, and View Log… are enabled.

- View Output was covered thoroughly in the tutorials; now we review the remaining options.

- Use the ↑ Up and ↓ Down Arrow keys on the keyboard to place the Current Record Indicator and select the request to be viewed.

- Click View Details….

View Details

- The Request Detail window displays.

- From the Request Detail window, you can review the Parameters, Schedule Options, and Upon Completion…details of the report.

- Had you entered Schedule Options and Completion Options when you originally submitted the report, you would be able to review them from this window.

- If you fail to End Date a scheduled request, clicking the Schedule button will give you access to do this. Instructions to do this are provided later in this document.

- Clicking OK displays the Requests window.

Diagnostics

- Clicking Diagnostics displays the Request Diagnostics window.
This window gives you information about the completion of the report.

Clicking **OK** returns you to the Requests window.

**View Log**

If you wish to view detailed information about the report run, you can review the Log file by clicking **View Log...**

---

**Note:** Based on the Browser you are using, one or more File Download windows may appear warning you of security considerations. Select the “Open” options and other selections, if required, to view the document in Microsoft Word.

---

The window that appears will contain a Microsoft Word document; no special formatting is required.

From the **File** menu, selecting **Exit** closes Microsoft Word.
- If you are not returned to the Requests window and a blank Browser window is displayed, click the File menu and select **Close** to return to the Requests window.

**Note:** Be sure to choose **Close** from the File menu instead of **Exit**. If you choose Exit, you will be exited from the Oracle Application, as well as the browser.
Formatting Reports Using Microsoft Word

Note: If you do not have the OracleReport tool, you may format the report using the Microsoft Word formatting features. This is not the desired method, but it will work until you have the OracleReport tool installed. Instructions to format a report in Word are given below.

- **Page Setup:**
  - Change the **Left** and **Right** margins to **0.5**.
  - **Orientation** – **Landscape**
  - **Paper size** – **Letter** or **Legal** (depends on the report being formatted)

- **Font Size:**
  - Click **Edit** on the Menu bar; choose **Select All**.
    - All the text in the document will be highlighted and the end of the document will display on your screen.
  - Click **Format** on the Menu bar and select **Font…** or use the **Formatting Toolbar** and change the Font size to **8**.

Note: You may have to repeat the above steps several times using different margins and fonts, before the report will display in a legible format.

Locating Specific Information

- To quickly locate specific information in the report, click **Edit** on the Menu bar and select **Find...** Click on the **Find** tab and enter an Asset Number or some other relevant information in the **Find what** field; click **Find Next**.
Finding Requests after Exiting AIS – Additional Information

(Unit 2: Navigation, Module 6: Running Reports, Learning Cycle 3: Finding Requests after Exiting AIS)

Specific Requests Search

- In Module 6, Learning Cycle 3: Finding Requests after Exiting AIS you learned the basics for Finding Requests using the “Specific Requests” option. This section provides additional information for using the “Specific Requests” option.
- Navigate to the Find Requests window.
  - Navigator Window ➔ View Menu ➔ Requests.
- The Find Requests window displays.
- Clicking the Specific Requests radio button activates the fields in the region.
- Enter search criteria in one of the pre-defined fields.
- For illustration purposes, we will enter data in each field.
  - If practicing, experiment with as few or as many fields as desired.
  - In Production you would normally use only one or two fields.
- **Request ID** – enter the Request ID for the specific request you want to view.
  - The Request ID appears in a dialogue box when you first submit the request to the Concurrent Manager.
- **Name** – enter the name of the report. If this is a report that is run often and you do not have the Request ID, all the reports with that name will be retrieved. The List of Values is not available for this field.
  - Field is case sensitive.
- **Date Submitted** – clicking in this field displays the LOV indicator; click it to display the Oracle’s calendar, if you wish to enter the date the report was submitted using the Calendar.
  - Or, manually input the date in Oracle Date Format (DD-MMM-YYYY).
- **Date Completed** – enter the date the report was completed in Oracle date format (DD-MMM-YYYY).
• **Status** – clicking in this field activates the LOV indicator. Select an available option from the picklist.

• You may need to scroll to find the correct status.

• **Phase** – clicking in this field displays the LOV indicator. Select an available option from the picklist.

• **Requestor** – enter your User ID.
  – The field is case sensitive.

• After entering data in one or more of the above fields, click **Find**.
The Requests window will display with the specific information requested.

You may click any of the enabled buttons on the window to view report information.

For this demonstration, we are going to close this window and return to the Find Requests window.

Order By

- Let's look at another search method.
- Clicking [Clear] removes any previously entered information.
- Select the All My Requests radio button.
- Order By – this field will allow you to select the order in which the request(s) will display. The default for this field is Request ID.

Clicking the LOV indicator for the Order By field displays a picklist for the field.
- Additional selections for displaying the requests in order are Name and Requested Start Time.
- We'll select the “Name” option.
• Clicking **Find** executes the search.

**Note:** Below the **Order By** field is a field entitled “Select the Number of Days to View”. In Production, the number of days you can view a report will be automatically limited to “five” days. After five days, the reports will be purged. You will not have the option of selecting the “Number” of days to view a report.

• The **Requests** window displays.

• The **Requests** are displayed, sorted by Name.

• The **Request ID** column is sorted in numerical order by default. **Notice the column is no longer sorted in numerical order.**

• You may click any of the enabled buttons on the window.

• When viewing is complete, clicking the **Close Form** icon on the **Toolbar** returns you to the **Navigator**.
Applying a Saved Schedule

Note: This section is for informational purposes only and should not be practiced in TRNT.

Note: It is not always necessary to create a brand new schedule for submitting a report. If you have completed scheduling options for a previously submitted report and would like to use those same options for a new report, you may Apply a Saved Schedule.

- To demonstrate “Applying a Saved Schedule”, we’ll begin at the Submit Request window.
- Use the List of Values to populate the Name field by clicking the LOV indicator.

- From the list, locate and highlight the desired report, and then click OK.
- For demonstration purposes, the Report, SIU FA – Cost Detail Report, was selected.

- The Parameters window displays.
- In Production you would enter the Parameters as prompted.
- In this demonstration, we will not enter the Parameters; but will click Cancel to proceed.
The Submit Request window displays with the Request Name field populated with the selected report.

To continue, click **Schedule...**

The Schedule window displays.

Click **Apply a Saved Schedule...**

The **Pre-defined Schedules** window (or previously saved schedules) will display.

The name of the schedule is highlight and schedule is applied by clicking **OK**.

- Notice that the **Schedule Name** and **Description** are both displayed and will help identify the schedule needed.
  - If necessary, use the **Horizontal** and **Vertical** scroll bars to locate the Schedule Name and to display the entire contents of the Description field.

**Note:** The report containing a saved schedule must have been run at least one time before the name of the saved schedule will appear in this window.

The saved schedule settings are now displayed.

- The **Schedule Name** and **Description** are displayed in the fields to the right of the **Apply a Saved Schedule...** button.
- The **Start At** and **End At** dates are shown.
- The “Periodically” run option has been selected and is set to Re-run every 14 “Day(s).”

Clicking **OK** applies the schedule settings for the selected report.
If an **End At** date was not entered, a dialogue window will display prompting you to enter an End Date. Enter an End Date to save system resources and to keep the report from running infinitely, or until it is manually end dated.

- The Submit Request window displays.
  - Notice the schedule entry in the At these Times… region.

- The Scheduling Options that had been set for the Pre-defined Schedule, have now been applied to our request for the SIU FA - Cost Detail Report.

**Canceling and Changing Request Options**

*Note: This section is for informational purposes only and should not be practiced in TRNT.*

Sec
Canceling a Scheduled Request

- To cancel requests that are scheduled to resubmit automatically:
  - Place the Current Record Indicator for the request record while in Pending Phase.
  - Click [Cancel Request].
  - The Phase changes to Completed and the Status displays Cancelled.

Or

- Place the Current Record Indicator for the request record while in Pending Phase.
- Click [View Details...].
- Click [Schedule...].
- Enter or change the date in the End Date field.

When the date/time designated by the End Date is reached, the Pending run in the queue processes immediately. The request displays the Phase as Completed and the Status as Normal.

Note: If you do not want the report to run one last time, do not change the End Date, simply Cancel.

Changing Request Options

- You can change request options of reports or report sets if the request meets the following criteria:
  - You made the initial request.
  - The request has not started running.
  - The program does not prevent request updates.

- Display the Requests window with your requests.
- Highlight the desired request.
- Click [View Details...].
- Click [Schedule...] to change:
  - Start and End Dates for recurring requests
  - Schedule Dates
- Click [Completion Options...] to change:
  - Notifications
  - Printer
  - Number of copies
  - Print Style
Folder Tools – Additional Information

(Unit 2: Navigation, Module 7: Folders, Learning Cycle 1: Customizing a Folder)

Autoquery Region Options

**Note:** This section is for informational purposes only and should not be practiced in TRNT.

- When creating a new folder, you should always select the **Never** radio button.
- The reasons are defined below.
  - **Always** – automatically queries for a subset of records each time you open the Folder definition. If Always is selected, you may encounter a problem accessing the Folder at a later date.
  - **Never** – this is the suggested option to select within the Autoquery region. This option should always be selected to avoid problems accessing the Folder in the future.
  - **Ask each time** – opens the decision box when the Folder is opened. If ‘Ask each time’ is selected, you may encounter a problem accessing the Folder at a later date.

Autosize All

**Note:** This section is for informational purposes only and should not be practiced in TRNT.

**Note:** Autosize All is an alternate method for resizing the fields in the folder as opposed to the Folder Menu options previously described in this lesson. The Autosize All function should be used with “caution”. If this function is invoked, you will lose any unsaved customizations made to the folder.

- To use Autosize All, you would place the cursor in one of the fields of the Folder Block.
- Then, from the Folder menu, you would select **Autosize All**...
• The **Autosize All** window displays.
  – The displayed fields resize based on a sample of values for the field in the block, ensuring that no field is smaller than the width of its prompt. The number of records is determined by selecting one of three options: 10, 50, or 100 in the decision window.

• To select an option, other than the default,
  – Click on the appropriate radio button,
  – And then, click **OK**.

### Saving Changes using Save As

**Note:** This section is for informational purposes only and **should not** be practiced in TRNT.

• First, you should reset the Query by selecting Reset Query from the Folder menu.

• Second, customize the layout of the Folder using any of the previously mentioned Folder Tools.

• Then, to save the changes to the current Folder under a new name, click on the Folder menu and select **Save As**.

• When the **Save Folder** window displays, enter the appropriate information.
  – Enter a unique Name in the Folder field.
  – In the Autoquery region, click **Never**
  – Select the Open as Default or/and Public checkbox(es).

• Clicking **OK** saves the changes under the new Folder name and a message will display on the Toolbar.

**Note:** If you save a Folder to "Open as Default", then open another Folder and save the second Folder to "Open as Default"; then the second Folder becomes the new default.

**Note:** If you modify a public Folder created by another user in any way, saving it makes it your private Folder. The public Folder you altered remains in its original format.